
                                                                                       

Address  Book
Version 2.0

            Navigation                       Reading this will be very helpful.
           File_Menu                          File Handling.
            Edit_Menu                          Data Base Handling.
            Options_Menu              Display Features.
            Dialing                                      Setup for phone dialing.
           Merging Database Files

         Registration Info.        Please look at this one.
         Registration Form    Another good one.



    
Green Arrows:    The single arrows will move through the data one record at a time.
                                                  The double arrows will page through the data file four records at a 
time.



    
The File Menu

The File Menu allows for creating, maintaining, and printing. It has the following options:

         New                    Create a new database file.
         Open                  Open a database file.
          Save                  Save the current database file.
          Save_As      Save the current database to a new file.
         Print                    Print Address book, Labels, Envelopes.
         Import              Insert records into the database.
         Export             Export records to a file.
         Exit                      Exit Address Book.



File New Menu

This selection will close the current database file and prepare for entering data into a new 
database file.



File Open Menu

This selection will present the open file dialog box for selecting an exisiting database file to be 
load.



File Save Menu

This selection will save changes made to the current database file.



File Save_As Menu

This selection will present the save file dialog to allow saving a current database to a new file.



File Print Menu

This selection will present a variety of printing options:

          Phone List Two Columns (Name and Number Only)
         Phone List (Condensed Name/Address/Phone)
          Pocket Size Address Book
         2-Up Labels 1 x 4 inches
          3-Up Labels 1 x 2-5/8 inches
          #10 Business Envelope: 4-1/8 x 9-1/2 inches
         Monarch    Envelope: 3-3/4 x 7-1/2 inches
          #6 Personal Envelope: 3-3/4 x 6-1/2 inches



Phone List Two Columns (Name and Number Only)

This will only the names and phone numbers in an easily read two column format.    A dialog box
is presented that lets you enter the Title of the list, fonts to be used, and Selection_Flags to print 
only the names of interest.



Phone List (Condensed Name/Address/Phone) 

This print selection    trys to cram the Name, Address, and Phone numbers on a single line. 
Names and address may be truncated at times if it can not all be displayed. The font size used for
the address will be reduced to squeeze it in the allowable space.    A dialog box is presented that 
lets you enter the Title of the list, fonts to be used, and Selection_Flags to print only the names of
interest.



Pocket Size Address Book

My desire to have a small address book prompted me to write this program. This selection will 
print in quadrants on the paper, and it will be done a fashion    that when cut and folded will 
produce an address book with dimensions of 4-1/4    x 5 -1/2 inches. The easiest way to see how 
this is accomplished to simply give it a try. 

You will first be given a dialog box to choose fonts to be used, and Selection_Flags to print only 
the names of interest.    You are also able to select which fields should be printed by selecting the 
appropriate check boxes. After you select print, and you printer stops you are only half way 
through with print job. A dialog box will appear asking you to remove the printed sheets and 
reinsert into the printer to print on the reverse side.    After doing this press OK to continue to 
print the second half. 

When the second stage of printing has complete set the sheets of paper down so that the quadrant
with the page number 1 is face up.    It will be in the upper right hand corner. Next cut the paper 
in half.    Now if you let the paper lie as it was before you made the cut,    simply reach up and 
grab all of the sheets    in the pile that has quadrant page number 1. Place this stack on top of the 
other stack.    The last step is to pick all the sheets up, fold them back, hit them with a staple and 
it is done.



2-Up Labels 1 x 4 inches

This printer selection will print standard    1x4 inch labels. There will be two across and 10 down 
for a total of 20 per page.    A    dialog box will permit the font choice and Selection_Flags to 
print only the names of interest. Selecting the Positioning button will bring up a dialog box for 
alignment and starting label position.



3-Up Labels 1 x 2-5/8 inches

This printer selection will print standard    1x2-5/8 inch labels. There will be three across and 10 
down for a total of 30 per page.    A    dialog box will permit the font choice and Selection_Flags 
to print only the names of interest.    Selecting the Positioning button will bring up a dialog box 
for alignment and starting label position.



Envelope Printing

This printer selection will print an envelope for the person whose name had the turquoise 
selection from the graphical address book. A dialog box will be presented that allows separate 
font choices and point size for the return address as well as the addressee. In addition you can 
select different point sizes for the first line of the return address and addressee. The Post Net 
code can be printed as well as a Note Line. 

The return address pulled into the dialog box comes from entries previously made in the Options 
Report Header dialog box. It was here that you could enter two possible return addresses. The 
two check boxes below the return address field labeled #1 and #2 will toggle between the two 
previously defined return addresses.    The edit box containing the return address can always be 
edited to change any or all text in the return address.

The addressee information was pulled from the turquoise selection from the graphical address 
book.    The work or home check boxes determine which address to use. The edit box containing 
the addressee can always be edited to change any or all texts in the addressee.

The Post Net code for the zip code can be printed.    The zip code that will be used for the Post 
Net is displayed in a special field.

To put a note on the envelope you need to select the NOTE button. This brings up a dialog box 
that lets you select from some predefined text strings, or you can edit your own. You may also 
select the font and point size for the note text string.

Though complete printer control of envelopes is not supplied, you can click on This Side , The 
Other Side, Front, and Rear to assist in envelope alignment. If you have a DeskJet printer try 
selecting The Other Side and Rear.    



Address Book Features

This section describes the features of the Address Book Graphics Display and Name List Box.    

The Address Book area permits navigation by using Tabs and Arrows. Clicking on the 
Alphabetic Tabs will take you to the first record whose last name begins with that letter. If there 
is no name starting with that letter no movement will be made. Clicking on the Green Arrows 
moves sequentially foreward or backward through the records. The single arrow will move one 
record while the Double Arrows will page through four records per time.

The Address Book area is also used to determine the active record. The active record is the one 
highlighted in turquoise. To highlight the record of interest simply click on the name in the 
Address Book. The active record will be the one used if you click on the Edit Button or select 
Edit from from the pull down menu. The active record will also be the address copied into the 
clipboard when selecting copy from pull down Edit menu.    Double Clicking on the name 
highlighted in Turquoise will cause the Edit dialog box to pop up for that record. The active 
record will also be the record used when you choose to print an envelope.

The List Box is the fastest way to locate the person you are interested in.      the name in the edit 
portion of the List will immediately highlight that person in the Address Book display. 

By using the scroll bars you can easily look at the names in your database. Clicking on a name in
the scroll area will make it the Active record. Double Clicking on a name in the scroll area will 
call up the dialog box for making modifications to the record.



Import

Importing and Exporting is the process of exchanging data between applications by way of text
files. For Adr_Book, importing also implies merging of records. If you import records into an 
existing Adr_Book database file, you will be adding records to that database.    These text files 
are often referred to as ASCII files.    These files contain separated text strings that correspond to 
individual record fields. i.e. Last Name, First Name, Phone Number, etc.    Most database 
and spreadsheet programs are capable of producing ASCII files containing their record 
information in separated fields.

When you installed Adr_Book onto your System, you should have received a Microsoft Write 
file. The file name is adrbook.wri and the icon name after installation was Tutor.    Refer to this 
document for a step by step example for importing and exporting.

Adr_Book Version 2.0 added many improvements for Importing and Exporting. It is very easy 
to specify the individual fields of your file, their order, and what separates each field. 

If you are attempting to import data into Adr_Book and not exactly certain how to proceed I 
would first suggest you read the Import / Export section of the document mentioned above. Next 
I would simply do some testing by using Adr_Book to Export some data and then Import this 
data back into Adr_Book.    When you do this, use a text editor to actually view your generated 
file.    This will give you a good understanding of what needs to be accomplished when moving 
the data in from some other application program. Good luck and have fun.



File Export

Exporting is the process of writing Adr_Book database fields into a text file so they can be used 
by some other application program.    I would like to refer you to the Import Topic since there is 
more verbage on the actually process that takes place. 

There is one important point to be aware on Exporting.

When the Export command is given, it will only export records currently selected as indicated 
by the flag field. By using the flags field you manipulated which records will be exported.



File Exit

Exit the Adr_Book program.



Edit_Menu

The Edit Menu manages the database file through Adding, Deleting, and Editing.

            Add              Create a new record.
           Delete      Delete a record.
           Edit              Modify a record.
           Copy          Copy to Clipboard



Copy to Clipboard

Selecting Copy will move a copy of the currently active Name and    Address to the Clipboard. 
This can then be used for inserting into your word processor etc.



Adding and Editing

Adding or Editing goes to a dialog that lets you do exactly what you would expect. The only 
point of interest is a dialog button that says "Add / Next".    If you have entered the dialog box for
Adding, "Add / Next"    will cause the record to be added and present you with cleared fields to 
allow entering of another record. If entered for Editing the "Add / Next" will bring up the next 
sequential record for editing.



Delete

Selecting Delete will bring up a dialog box asking if you really want to delete this record. The 
record to be deleted will be the one currently highlighted in turquoise.



Options Menu

This menu permits setting configuration items.

          Display                            What will be displayed on the Address Book.
          Report Header      Titles and Return Address for printing.
         Mode (US/International)                      Address entry field.



Mode (USA/International)

USA mode allows for entry of State and Zip code in a fasion that is typical in the United States.   
International mode gives four complete address lines for entering State, Zip and Country in any 
appropriate fashion. For a better explaination simply select this option from the menu and read 
the description provided.



Report Header

The dialog box presented allows you to enter two text lines that will be used at the top of printed 
reports.    This is also the place where default return addresses are entered for use when printing 
envelopes.    



Display

The dialog box presented allows choosing what information will be displayed on the graphical 
address book.    Because there is limited room on the display not all record elements can be 
displayed. Additionally, you can specify which records will be displayed by using the flag fields.

The ability to display the Note field was added to version 1.3.    By selecting the Note check box 
you will see a Note.. text string highlighted in red appear on the graphical address book for any 
record containing note text.    By clicking anywhere in this red area a pop up list box will appear 
to display the text. Clicking anywhere will cause the list box to disappear.



Flags

Entering codes in the Flags Field permits printing, exporting, and displaying records of particular
interest.    The operations that can be used with the Flags are OR, AND, SEQ, and NOT. Listed 
below are explainations of how you would enter codes in the dialog boxes for printing, exporting
or displaying records.

The OR option will select all records that have any of the codes you list in flags field. Imagine 
you entered a flag code of T for friends that play Tennis and an R if they like to play 
Racquetball.    Now if you felt like playing Racquetball or Tennis and wanted to find people who 
might be interested in either of these sports,    in the flags field of the dialog box you would put 
TR and then select the OR check box.

The AND option will only select records if all codes listed are present in the flags field for a 
record. Imagine you needed to find a woman to fill out a golf foursome. If you used the codes F 
for female and G for golfers, you would enter an FG in the in the flags field of the dialog box 
and then select the AND check box. 

The SEQUENCE option will only select records that have a matching string of characters.    If 
you used words like JULY and MARCH to represent the month of individuals birthdays, 
entering the word JULY in the flags field of the dialog box and then selecting the Sequence 
check box would list people with birthdays in July.

The NOT check box reverse the sense of the match. In the example above for finding July 
birthdays, if the NOT check box was also selected you would have a list of all people who did 
not have a birthday in July.



Registering ADR_BOOK Ver 2.0
First of all, if you find this program useful that's GREAT!    I would like to hear from you with 
any suggestions you have, no matter how trivial.    Feel free to write to my address below, send 
E-mail to mikeg@ims.alaska.edu. or mikeg@alaska.net or call (907) 278-1231

If you have decided that you like ADR_BOOK and would like to register, please send a check 
for    $20.00    in US funds plus $2.00 for shipping and handling.    ($5.00 shipping and handling 
for International orders.)    Make payable to  Brown Bear Software or to Michael Gardner.    I 
make every effort to ship in 24 hours.    Mail to:

                    Michael Gardner
                    1231 Redwood Ct.
                    Anchorage,    AK    99508

Please send the registered version to:

Name:

Address:

Please ship    ________    copy(s)    of    Adr_Book

Price $20                    ________    ( 20% discount on 5 copies,    30% discount 10 copies or more)
Shipping                      ________    ( $2 U.S. orders,    $5 International Orders)

Total Price                ________          

Payment          ____ Check                    ____ VISA                        ____ MasterCard

Credit Card Number _________________________    Expiration Date ________

Name Printed on the Card __________________________________________

Where did you find    Adr_Book _______________________________ 

Any Suggestions:



ADR_BOOK Ver 2.0
This is a shareware product produced by  Brown Bear Software - which is really just another 
name for me, Michael Gardner. Clicking on Registration Form will bring up a form that you can 
print and mail in to receive your registered version. 

Feel free to examine this product completely.    If you find that you are using the product, please 
do the    RIGHT thing and Register. 

You can also register by calling (907) 278-1231.    This number is in Alaska.

As a registered user you will receive the latest version of Adr_Book.      I could list several other 
registration benefits like technical support, upgrade notification    etc.    But the truth is you will 
feel better, I am quite sure I will feel better, and I am absolutely positive, Alberta, my much 
better half, will feel better. 

Contact me for any questions:

            Internet Address:      mikeg@alaska.net    or mikeg@ims.alaska.edu
            Phone:  (907) 278-1231



Merging Database Files
 
By example let us say you have created three database files: file1.adr, file2.adr, and file3.adr.    
To merge these into a single database file you    first need to open one of the files and and read it 
into Adr_Book.    Of course you know how to do this, and lets say you load file1.adr.    To merge 
file2.adr select Import from the File menu.    When you get to the Import dialog box click 
Open... From the Open Dialog Box click on the arrow down by the List Files of Type:. You will 
see an option that says Database Files(*.ADR).    Click on this.    Now in the file list above you 
will see your    database files.    For this example you would see file2.adr. Opening this will then 
merge file2.adr with file1.adr.    Do the same operation again for file3.adr and you will have a 
single database file. Not so bad!



Dialing
Phone Dialing is a new feature with Adr_Book Version 2.0.    It is necessary to activate this 
feature before you can actually click and dial.    Once you have set up this feature, clicking on the
Yellow and Black phone number in the address book display will initiate a call.

To get the Dialing dialog setup screen select Setup from the Dialing Menu option. The first thing
you must do is click on the radio button associated with the COM port that has your modem    
connection. 

If you need to prefix all phone numbers for an outside line, you can enter the number or number 
sequence into the prefix box.    This is often used, for example, to hold a number like nine (9) to 
obtain an outside line from an office building.

An IMPORTANT step is to check the Enable Dialing check box. This must be checked before 
Adr_Book will respond to your clicking on the Yellow and Black phone numbers.    Select OK 
to save this configuration.    Remember, if you want to save this configuration setup, you must 
issue a Save command from the File Menu.

All you need to do now to initiate dialing is to click on a Yellow and Black number.




